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The company also boasts of a FITEI special export award in the wvear

1998-99 . It has also won the Govt . of INDIA Department of

Electronics award for its excellence in the field of electronics .
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SYNOPSIS

Quality of Shiver-eye determines largely the quality ©f
yarn produced . As any meaningful correction of quality deviations
being practically possible only m the drawframe Shver-cye stage., s
imperative that quality control 1s strictly exercised  at this stage -
otherwise , tracking and correcting quality deviations in the subseguent
processes such as roving and spinning is practically time consuming
and it only adds to the production  cost . The uncorrected quabity
deviation will ultimately end up in poor fabric appearances and will
show as fabric faults such as streaks and stripes etc .

with the use of high speed Modern Avtolevelier
Drawframes , even a few minutes production of defective quality would
end up in the production of kilometers of vam . Frequent machine

stops  will  only add to  changes quality  levels

Vil



Decisive to the yamn quality characteristics ., thus , are the
Sliver-eye quality characteristics as mass variations of  higher <t
jengths , evenness characteristics , periodic faults and thick and thin
places in Sliver materials . These Sliver qualities directly influence
count CV % , evenness and seldom occurring faults of yarns.

Online monitoring  of Sliver quality thus assumes
significance , otherwise much material will be wasted before ofi-iine
inspections points out any deviations .

Off-line inspections are only sample-based and hence
100 % detections of deviations are impossible to achieve. Sliver-eye
monitors online the quality and production parameters for preparatory
machinery such as drawframes and combers . The central idea of the
project will be to display data from all Sliver-eye units in a single
PC using NATIONAL INSTRUMENTS software LabVIEW as e

front end . The test results are also given in this report.

viil



CONTENTS

CERTIFICATE
ACKNOWLEDGEMENT
ABOUT THE COMPANY
SYNOPSIS

CONTENTS

CHAPTERS

1. SLIVER EYE 5000
1.1 AN OVERVIEW
1.2 PARTS OF SLIVER-EYE UNIT
12.1 CONDENSER UNIT
1.2.2 PROCESSING AND DISPLAY UNIT
1.2.3 POWER SUPPLY UNIT

2. INTRODUCTION TO LabVIEW
2.1 INTRODUCTION
2.2 PLANNING AND DESIGNING PROCESS

3. VIRTUAL INSTRUMENTS
3.1 FRONT PANEL
3.2 BLOCK DIAGRAM
33 ICON/CONNECTOR

4. MENUS
4.1 POP-UP MENUS
4.2 PULL DOWN MENUS

5. ABOUT PALETTES
5.1 TOOLS PALETTE
5.2 CONTROLS AND FUNCTIONS PALETTE
521 CONTROLSPALETTE
5.2.2 FUNCTIONS PALETTE

V11

U (S I S R

I~

o0

b B

FEg

1

-
T



6. VI LIBRARIES
6.1 CREATING AND EDITING A Vi
6.1.1 CREATING A SUB VI
6.1.2 EDITING A SUB VI
6.2 STRUCTURES
6.3 ARRAYS AND GRAPHS
6.4 CASE AND SEQUENCE STRUCTURES
6.5 CLUSTERS

7. SERIAL PORT COMMUNICATION
8. SLIVER-EYE CONNECTIVITY

9, CONCLUSION

10. REFERENCES

11. APPENDIX

[R]

(O S C T SO T L O
s T T

P et

b
N

2
o

29



Chapter — 1

SLIVER-EYE 5000

1.1 AN OVERVIEW

Sliver-eye 5000 , an online quality and production monitorng
systems for preparatory machinery such as drawframes and combers .
measures and displays the important Sliver-eye quality characteristics
such as:

1. Um% and CVm % :evenness characteristics
2. CV%[05m, Im,3mé&
S5m cut lengths ] @ cut length variations
3 Pm % :mass variations
4. Spectrogram - periodic faults
5 Thick & thin places : short term mass variation and
helps producing betier and consistent Sliver quality .
The production parameters include :
1. length produced
2. machine Stops
3. efficiency , €tc .

are also being monitored and displayed .



1.2 PARTS OF SLIVER-EYE UNIT :

The different parts of the Sliver-eye unit are :
1. Condenser unit
2 Processing & Display unit
3 Power supply & Display unit

12.1 CONDENSER UNIT:

It basically consists of a strain gauge Sensor which 13
embedded inside a condenser . specifically designed for this purpose.
As the Sliver passes through the condenser . the materal gels
compressed in the D-profile and exerts a force on the sensor which
is directly proportional to the volume of the Sliver.

The construction of the condenser is specific to every machine .
Inorder to accommodate the various count of the materia. . e

condenser unit 1s made with various s17€eSs .



As the Sliver material passes through the condenser, fluft and
other micro-dust gets deposited near the sensor . Inorder 1o TEMOVE this
dust , the sensor 18 continuously cleaned with a mild blow ¢t
compressed air . To facilitate this and increase the efficiency of the
system an oil filter with a regulator is provided . The sensor PCB
circuit is shown in fig 1.1.

The sensor PCB consists of

1. strain gauge

2. precision instrumentation amplifier

1.2.2 PROCESSING & DISPLAY UNIT :

The PDU consists of:
1. Analog conditioning & signal processing unit
7 Production monitoring & storage unit
3. Liquid crystal display (LCD)

4. Keyboard

(')



The input to this unit is got through the sensor cables i the
form of analog signals . The 80196 microcontrolier is used for the
analog conditioning and signal processing . It is used to sense the
signals . The 80C320 microcontroller 18 used for production monitorny
and storage .It has 8 bit address line with 40 pins . It helps =
interfacing the keyboard and L.CD . The LCD is used 10 disolay the
results of analysis . The results are displayed only if the keyboard s

locked .

1.2.3 POWER SUPPLY UNIT :

The power supply unit produces all the required regulated
d.c supplies for the functioning of the PDU.

The block diagram of the Sliver-eye unit is shown in fig 1.2.



sensor i/p from PDU

|

Bridge Instrumentation

— sensor o/p
Rectifier Amplifier

Fig 1.1 — Sensor circuit
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Fig 1.2 - Block diagram of Sliver-eye unit
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Chapter — 2

INTRODUCTION TO LabVIEW

2.1 INTRODUCTION:

LabVIEW ( Laboratory Virtual Instrumentation Engineerimg
Workbench ) is a powerful graphical programming 1anguage for virtuai
instrumentation and analysis . It can be used with the following 0S -
MICROSOFT , Windows, concurrent Power Max , HP-UX work stations,
etc . LabVIEW departs from the sequential nature of traditional
programming languages and features a graphical programming
environment and all the tools required for data acquisition analysis
and presentation . With this graphical programming language caliec
“ (G, one can programl in ablock diagram notation. the natural design
notation of scientists and engineers . After the creation of the block
diagram program, LabVIEW compiles it into a machine code .

LabVIEW integrates data acquistion , analysis and presentatior N

one system . kFor acquiring data and controlling instruments . L.abVIEW

~-



supports RS-232 /422, 1EEE 438 and VXI . including Virtual Instrumer.
Software Architecture ( VISA ) functions . as well as plug-n data
acquistion ( DAQ ) boards . An instrument  library  with drives ¢l
hundreds of Instruments simplifies mstrument control applications . For
analyzing data , the extensive analysis library contains functions for
signél generation signal ~ processing . filters . windows, statistics.
regression , linear algebra and array arithmetic .

Since , LabVIEW is graphical in nature, it is inherently a data
presentation package . Using LabVIEW . one can generate charts . graphs

and customized user defined graphics .

3.2 PLANNING & DESIGN PROCESS :

To design larger projects using LabVIEW . a top-down
approach 1s usually preferred . The step by step procedure irvolved in
solving the problem is explained by means of a flow diagram . The

diagram for the entire process is shown in fig 2.1.



LabVIEW project development process defines the genera:
characteristics and specifications of the project . We begin by
developing sub VI's , ie sub programs which are eveniually assembled
to form the complete project . This stage represents = Bottom-up -
development period , customer feedback helps In determining new

features for next version .

V]



Define Process Test& :
project feedback release !

Design Integrate | '
| flowchart sub VI ! ;

Implement
Nodes using

Test sub VIs
Vis

Top-down Bottom-up |

Fig 2.1 — Flow diagram for planning and design process
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Chapter — 3

VIRTUAL INSTRUMENTS

LabVIEW programs arc called Virtual Instruments (Vs ). Vs
have three mam parts . They are:
1. Front panel
2. Block diagram

3. [con / connector

3.1 FRONT PANEL:

The front pane! is a means of setting input values and
viewing outputs from the VI block diagram . As the front panel is
analogous to a front panel of a real instrument , the input’s are to as
Controls and the oufputs are referred to as Indicators . There are
variety of controls and indicators , such as knobs , charts . switches .
buttons , graphs and so onto make the front panel easily identifiable

and understandable .

11



3.2 BLOCK DIAGRAM:

Fach front panel has an accompanying Dblock clagram.
which 1is the VI program. The block diagram is built using the
graphical programming language called G 7. The block diagrar-
acts as a source code . The components of the block diagram
represents  nodes , for example : For loops . (Case  slructurcs.
arithmetic functions . They also have constants , functions . sub
VI’s , structures and wires that carry data from onc object 10
another . The components are wired together to define the flow

of data within the block diagram .

3.3 ICON / CONNECTOR:

The icon / connector is used to twrmn 2 V1 into an object
(sub VI). This can be used as a subroutine in the block diagram of
other VD’s .The connector terminals determine where the inputs and

ouputs are wired on the icon . The terminals are analogous 10



parameters passed to a subroutine . They correspond to  the cOntrots
and indicators on the VI front panel .

The power of LabVIEW lies in the hierarchical nature ©f
the VI . After a VI is created , it can Dbe used as a sub VI om (e
block diagram of a higher jevel VI.There is no limit on the numbe”
of layers in the hierarchy . This featurc makes the block diagran:
modular and easy to debug . understand and maintain .

Both the panel and the block diagram windows contain 2
toolbar of command buttons and status indicators that can be used 10
control a V1. The toolbar appearing on the block diagram is quiic
familiar to toolbar appearing on the front panel ecxcept for & icw

additional debugging features .

.‘._
Lad



Chapter — 4

MENUS

The LabVIEW has both pop-up and pull down menus .

4.1 POP-UP MENUS:

Most commonly used one is the pop-up menu . All the
objects used to build the VIU's are provided with pop-up menus for
selection and modification . The process of accessing the pop-up menru

is known as popping up .

4.2 PULL DOWN MENUS :

The menu bar at the top of the LabVIEW screen contains
several pull down menus . The pull down menus contains options
common to most applications , such as Open , Save . Copy and Pastc as
well as many others particular to LabVIEW . The pull down mend 1S
shown in fig 4.1.

The options in the File menu are primarily used to open.

save , close and print Vi's.

14



The options in the Edit menu are used 10 mocity the

front panel and the block diagram objects of a V1 . These options aid

used to manipulate and arrange LabVIEW components to 4 speciiic

taste .

The commands in the Operate menu are used 10 exccuil

the VI.

The Project menu is 10 obtain additional information

regarding the VI . its sub VI's and windows .

The Windows menu is used to locate opened windows

quickly and to open windows of sub VIs and calting VIs.

The Help menu is to view information about the panel or

djagram objects , 10 activate the online reference atilities anc to view

information about the LabVIEW version number and computer

memory.



-1l

File Edit Operate Project Windows

New Ctrl+N Show Help
Open ... Cirl+0

Close Crrl+W Lock Help

Save

]

Ctrl+S

Fig 4.1 — Pull down menu
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Chapter — 3

ABOUT PALETTES

LabVIEW has both graphical , floating palettes to aid in creating
and operating the VI’s . The three palettes include the followinz:
1. Tools palette
2. Controls palette

3. Functions palette

5.1 TOOLS PALETTE :

The tools in this palette are used to create . modify and
debug VI's . 1f the tools palette is not visible . select Show Tools
Palette from the Windows menu to display the palette. Once the tcol
is selected , the mouse Cursor takes its shape . The information
regarding the tool can be got from the Help menu by rlacing the

cursor on the tcon.



52 CONTROLS & FUNCTIONS PALETTE :

The controls and functions palette CONsIStS of top-ieve:
icons representing subpalettes , giving access to a full range ©f
available objects that are used in creating a Vi . The subpaleites car
also be accessed by clicking on the top-level icons . 1t car, re
converted to a floating palette that remains on the screen by tacking

down the thumbtack on the top left corner.

5.2.1 CONTROLS PALETTE :

Controls and indicators needed in the front panel can oe
added via the Controls Palette . Each option in the palette displays a
subpalette of available controls and indicators for that selection . !f e
Controls Palette 1s not visible , select the Show Controls Palette
from the Windows mcnu . The palette can also be accessed DY
popping up on an Open area in the Panel window . Then it can be

tacked into a floating palette by clicking on the pushpin on the op

left comer of the palette .

This palette Is qvailable only when the Panel window iy acuve .

18



5.2.2 FUNCTIONS PALETTE :

The block diagram is built using the Functions Palette .
Each option in the palette displays a subpalette of top-level 1cons .
ihe Functions Palette is not visible , the palette is opened by selecting
Show Functions Palette from the Windows menu . Similar ¢ the
Controls Palette , the Functions Palette can be popped up o &n
open area 1n the Diagram window . [t is then converted mto a floating

palette by clicking on the pushpin .

This palette is qvailable only when the Diagram window is

active .

19



Chapter — 6

VI LIBRARIES

The VI's can be loaded and saved to/trom a special file callec
V1 library . Some of the advantages of using the Vi library ave:
4 755 characters can be used to name VI's,inclucing
“ _vi” extension .
4 V[’s are compressed to save disk space .
# Because multiple VI's are in a single file , it is easier ©
transfer VIs between computers .
The other characteristics of the VI library include :
# They are not hierarchical i nature, ie .11 cannot creats
VI library within another VI library .
# Saving and loading Vls to and from the file system :s
faster than to and from VI libraries .
# VI libraries can be transferred between platforms .
are portable  hetweei

Certain operating system-specfic VIE's

platforms .



6.1 CREATING & EDITING A VI

The VI is created using the controls and indicators . The
block diagram 1s made up of nodes , terminals and wires . The contro!
terminals have a thicker border than indicator terminals in the bilock
diagram . To change a control to an indicator , pop up On the terminai
or object and select Change to Indicator ( Control) . A mnode execules
only when data is available at all its input terminals ; the node supplies
data to all of its input terminals when it finishes executing and e
data passes immediately from the source to destination termina.s .
Using execution highlighting , single stepping and break points anc
probes helps debug the Vls casily by tracing the flow of data .

[abVIEW single stepping features include :

Step Into Button: single steps 1nto sub VIs . loops and so on for
debugging .

Step Over Button: enables single-stepping mode , bypasses singie
stepping through node and pauses at the next
node in the main VI.

Step Out Button : stops single stepping through a node and returns

to the main VI.

21



6.1.1 CREATING A SUB VI:

A VI that is used as a sub VI needs an icor
represent it In the block diagram of a calling VI . The sub VIomust
have a connector with definite number of terminals to pass data i
and from the higher level V1. The Icon Editor creaies icons for the
VI . The Required , Recommended , Optional classifications assigned
{0 the input terminals make it easier to prevent common wiring
mistakes . Show VI Info allows to document and maintain pertnent

comments about the V1.

6.1.2 EDITING A SUB VI:

Using the various tools in the tool palette . the sub
V] can be selected , moved , deleted and labeled . For this purpose the
positioning tool , wiring tool , labeling tool , etc ., are used .The sub V1
can also be resized , font changed , aligning and distributior. can aisc

be done .



6.2 STRUCTURES :

This controls the flow of data in a V1. LabVIEW has -
structures to control program flow - While loop . Casc structure . For
loop and Sequence structures . The While 1oop repeats a part oi the
block diagram code multiple times until the condition is true. The For
loop repeats the block diagram code for a predetermined aumber of
fimes . The Waveform chart is a special qumeric indicator that
displays one or more charts . It has 3 update modes :

# Strip chart: scrolling display

# Scope chart: plots data until it reaches the right

border , erases plot and retraces the plot from lefi .

# Sweep chart: retracing display with moving vertical

line between old and new data .

Shift registers are used to remember stored values from one
‘teration of a loop to the mext. Pop-up on a waveform chart is usec
to set attributes . Coercion dots appear when [ abVIEW is forced 1o
convert a numeric representation of one terminal to match the numeric

representation of another terminal .



63 ARRAYS & GRAPHS :

An array is a collection of data elements of the same typc.
The data elements can be of any type — numeric string , Boolean . B3
selecting an array shell in the window and adding the desired CONtrot
or indicator to the shell the array can be created . Polvmorphism s
the ability of a function to adjust to nput data of different data
structures . Waveform graphs and XY graphs display data trom arrays .
Graphs have many unique featurcs used to customize the plot displays
_More than one plot on a graph can be displayed , this becomes &

multiplot graph when the array of outputs arc wired to the terminai.

64 CASE& SEQUENCE STRUCTURES :

It is used to control the data flow . LabVIEW cepicts
both structures like a deck of cards . The Case structure 15 used to
branch different diagrams depending on the input to the selection
terminal of the case structure . The sub diagrams are placed inside the
border of each case structure . The case structure may be Boolean .

string OF Numeric .

24



The Sequence structurc is used to execute the diagram in a specific
order in the frame . The sequence locals pass values O the frames and
they are available in the frames in which they are created . With the
formula node , the formulac are directly entered into the block diagrai
This is useful when the function equation has many variables or it is
complicated . The variable names are case sensitive and each formula

(13 kal

statement must end with a “

6.5 CLUSTERS:

A cluster is a data structure that groups data . even or
different types . The various front panel controls and indicators needed
to be associated with the terminals are grouped under clusters . Objects
under clusters must all be controls or all indicators . Using the cluster
shell the clusters can be created , while working with these order of
components 18 critical . Error clusters are a powerful method of error
handling . These pass information from one VI 10 another . An error
nandler at the end of data flow receives the error cluster and displays

information on the dialog box .



Chapter — 7

SERIAL PORT COMMUNICATION

Serial communications 1is a popular means of transmitting data
between a computer and a peripheral device such as programmab.c¢
instrument or even another computer . It uses a transmiiter  and
receiver to send and receive data bits at a time. It 1s popular because
computer has large number of serial ports and so no external
hardware other than a cable ‘s needed to conmect the nstrument 0
the computer . Serial communication requires to specify 4 parameters

4 Baud rate: it 1s a measurc of how fast data moves
between instruments .
4 Data bits: it encodes a character . It is transmitiec
upside down and backwards .
# Parity bits: it follows the data bits in the character
frame . It is used for error checking .
# Stop bits: it is the last part of the character frame

having 1, 1.5,2bits.



RS — 232, RS — 422 , RS - 423 are the different types of senal
port communication . In this project RS — 232 are madc use of . It 18
developed by the Electronics Industries Association ( EIA ) and otner
parties specifying  the serial interface between the Data Terminal
Equipment ( DTE ) and Data Communications Equipment (DCE) . b
includes electrical signal characteristics { voltage Jevels ) . interface
mechanical  characteristics (connectors ) functional  description  of
interchange circuits ( functions of each electrical signal ) and some kind
of recipes for terminal-to-modem connections . Most frequently
encountered version 1s called RS —232C with high degrees of fidelity .

The PC to PC connection is shown in fig 7.1.

27
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Fig 7.1 -PC to PC connectivity

using RS-232



Chapter — 8

SLIVER - EYE CONNECTIVITY

Having knowledge about the various topics and the
additional features of LabVIEW, the front panel and the various block
diagrams associated with the Sliver connectivity are designed as shown
in fig 8.1 and 8.2. The software written in LabVIEW consists o7 a front
panel ., which displays all the quality and production parameters . For
the purpose of testing , a simulator , which simulates the Sliver-ey¢ data.
has also been written in LabVIEW as shown fig 8.3 and 8.4.

The simulator program 1s run on a PC . which 18
interconnected by RS-232 protocol to another PC from where the user
monitors the quality and production parameters . A request pattern 15
made to send, if it matches the prewritien request format , data 1s sent
to the user’s terminal and then the data can be cenveniently
monitored using the tabular columns shown 1n the program shees .

The program is written to monitor the data from two Shiver-eye units .



The Quality data table consists of the following

parameters :

o U%

o CV%

. CV%(O.Sm,lm,Bm\Sm}

o PM%

o Doff Start Time

e Doff End Time

The Production data table consists of the following

parameters :

o Shift number

e Hank (for delivery 1 &2)

e Hank unit

e Length

e Kilogram { for delivery 1 & 2)
e Efficiency

e No. of stops

e Stop duration

e No. of doff



e Doff duration

e Monitored time

The front panel and the block diagrams are shown in fig 8.1 -84

The program is an integration of various sub VI's like,

Serial Port Init. Vi
Serial Port Write . \%
Bytes at Serial Port. vi

Serial Port Read. vl
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To check all the bytes are
received from the post

|
PRI SRR aTt m |
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List of SubVls

stan ] Serial Port Init.vi

DWATIONAL INSTRUMENTS\Lab\/IEW\vi.lib\Instr\Serial.llb\Serial Port Init.vi
=W Serial Port Write.vi

D:ANATIONAL INSTRUMENTS\LabVIEW\vi lib\lnstr\Serial 1Ib\Serial Port Write.vi
Bytes At Serial Port.vi

DANATIONAL INSTRUMENTS\LabVIEWI. hb\Instr\Senal lIb\Bytes At Serial Pori.vi
i‘-‘-}g Serial Port Read.vi

DANATIONAL INSTRUMENTS\LabVIEW\Vl lib\lnstriSerial. llb\Serlal Port Read Vi
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Chapter — 9

CONCLUSION

The online quality monitoring of yarn was designed and
tested using LabVIEW . The prime advantage of online quality and
production monitoring is that 1t brings down the production  Cost
considerably . Also the quality of yarn can be monitored from any
remote location .As 2 future expansion of this project many Sliver-cye
units can be monitored using a single PC with the same software.
Further long time reports can alsa be generated . The database can bC

enhanced 1o handie bulk data.

TShvcr 1 — Sliver \ Sliver 1
;:] {

cesseen 'F_J

Computer
Using
LabVIEW |
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iniroduchon {01 JpvHEW

You usc the Help menu 1o view nformation about panct 0f dragram objects,
\o activate the online reference utihiis, and 10 ViEwW ~formanon @hout your
LabVIEW version number andd Commule F MeImary.

[ vic> MR

Show Help Cui+H Aclivales the Phep window
Lock Help Crd vl Locks 1he Help windaw Sereen of one sutyec .
J Gimple Help Cnables the simple diagram viow in the Hilp window. "

e —

|
Criine Refeience... Cul? Opens 1he LabViIew Onlie Retmance vy !
Oriling Help fos Untitled 7 Disprlay onhe el tor e cuiend VI \
DS . ——— |
Explain Enot... Shows o 10f chestar valugs ang missage Lor detaging ‘|
Intemnet Links r Opens dirac! Intarnal links to Natonal insi neinls i
Online Tutcaat. Launghus the mteactive onling lorial. |

Seaich Lxamples... -
Tlechrical Support Form..

1 ivdagql...
Shows you: LabViiiw version and memory niormation.

About LabVIEW...

LabVIEW has graphical, floating palcltes 10 aid in creating and operaling
V1s. The three palettes include the Tools, Controls, and l'unctions paleites.

Cpens a ulility thal searches through all oxnmpic Vis. |
Calls the (aehnical suppont {orm 10 log probiams :

e ————— N

palettes

Tools Paiette

You can create, modify, and debug Vicusing the tools located in the floating

Tools palette. 1f the Tools palette 1s not visible, select Show Tools Palette
from the Windows menu Lo display the palette. After you sclect a 10! from
this meny, the mouse cursot takes its shape. (Windows—-You also &on access
the Tools palette by pressing <shift> and the right mouse butlon.
Macintosh—Access the Tools paletle by pressing ccommanl-shift - nnd the
mouse button.) Place anv too! found in the Tools paictle overa subVlor
function icon to display nformation periaining Lo that subVi or furction i
the Help window. You frst must select Show Tleip from the Help ment.

% Operating tool. Use the Operating 1001 10 aantpelens the valuos of fm
panel controls and indicaters,
The toul changes (o the icun shown loft wher o pesses over sl Coed
control. such as a digial ot stning controt,

[ ¥ . s 5
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{esson | Introguchcn 1o LadVIEWS

N Positioning ool Use the Positioning tool to select, move, or resize ohiects,

I O The too! changes to the icon shown al lef. when 1t passes over 2 Comer of a
resizable object.

‘g] I Labeling tool. Use the Labeling tool to enler texi into iabels.

@ ‘The Labeling tocl changes to the icon shown at left when you create free
labels.

-‘@} wiring tool. Use the Wiring tool to wirce objects together on the block
dingram. Place the Wiring toel over & wirc to display the data type of the
wire i the Help window, You first st se lect Show Help from the Help

L

UEU pop-up menu o], Use the object pop-up mend tool to pon up ¢n an
chject’s pop-up menu with the left mouse button.

{fh; gerolling tool. Use the Serolling tooi to scroll through windows withoul
using scrolibars.

Breakpoint tool. Use tie Breakpoint ool to sct breakpoints on Vs,
functions, and structures.

.- Probe tool. Use the Probe ool Lo create probes on wires in the block

daggrant.

* Color Copy tooi. Use ihe Color Copy tooltocepy colors for pusting with the
’ Cuoloring ol

Y Coloring toul. Use the (oloring ool to color an object. It also cisnlays the
Fcd foreground end background of the object.

Controls and Functmns Palettes
e Controts and Iunctions peleties consist of top-level icons r:cprcscmis\g
&.npaluucs, alvangactossing full range of avarladle objects that you can use
i creating @ V1. You con avcess the subpalettes by clicking on .he ton-level
e Yo b o ennaend the subypuadeile foa Phontang pistette tat LIRS

Oiyou s by Lachane, down he thambitack attop left cornar of the

subpaletie.

Controls Paletie

You add controls and indicalors 1o the front panct via the Controls palette.
Fach option in the paleiic displays a st bpaletie of ¢ available controls and
incrcators for th seles on . 1 1he Contr ulys e h e ig not visthic, you canl
ofwn the palette by scieciing Show Counireis Paletie frorn the Windows

© National iastrumen(s Corparation s rabVIEVY Basics | Course idanual



LESSO:’I | introduchon lo LabVIEW

menu. You also can access the Controls puletic by popping up 07 an Gpen
arca in the Pancl window, Then you can tack down (e Controls palcticnto
a floating palette by clicking on the pushpin on the top lefl comer of the

palelle.

e HNote The Controls pulctic is available only when the Panel window iy avlive.

Numeric subpaleite. Consists of controls an | indicators fur nuperic data.

i

Boolean subpalette, Consists of contrls and indicators for Booican vajues.

String subpalette. Consists of controls and indicators for sirings and tubles.

0 =

List & Ring subpalette. Consists of controls and indicators for menu ings
oei | and listboxes.

28

E 3] Array & Cluster subpalette. Consists of controls and indizators that group
sets of data types.

Graph subpalette. Consists of indicators to plot data in graphs or real-time
charts.

)

Path & Refnum subpalette. Consists of conirols and indicators for {iic
paths and refnums.

(v
8

Decorations subpaletic. Consists of graphicz! objects for custemizing {ront
panel displays.

ol
1{3&\

LabVIFW Basics | Course Manual. 1-16 i @ Naliora! Insiruments Corparalion
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yu User Controls subpalette. Location for plucing users’ controls.

0.0’} Activ?X subpalette. Consists of controls an¢ indicators that aliow ActiveX
&3] Container capability (PConly).

Seleet a Control subpalette. Displays 2 dialog box to load custom controls.

Functions Paleite
You build the block diagram with the Functions paletie. Each option in the

palette displays a subpalette of top-level icons. If the Functions palette is
a0t visible, you can open the paletie by selecting Show Functions Palette
from the Windows menu, YOu access the Functions palette by popping up
on an open arca in e Diagram window. Then you can convert the
Functions pafette to 4 foating palette by clicking on the pushpin.

3 HNote The Functions paletic is available anly when the Diagram window is active.

Styuctures subpaleite. Consists of program control structures such as For
Ims! Loops.

P>‘ Numeric subpalctte. Consists of arithmetic, trigonomctric, loparithmic, and
()]

9. numeric functions.

& Nationa! Instrurents Cor malio. I a5VIEW Basics | Course Manual
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~d Boolesn unciions

7 Boolean subpaletie. Consists of Topat &

war

~—3 String subpaletic, Consists of funcons 10 Manipuiiie Segs,

wlig

Array subpalctie, Consists of functions to process ariys.

DNH

L)

—1 Cluster subpalette. Consists of funciions 10 process clusters.

0

7| Comparison subpalctte. Consists of functions to compare AUMDETS,
B> Booleans, and strings.
G Time & Dialog subpalette. Consists of functions for dialog windows,
/ - timing, and error haadling.

[%i; File /O subpaletic. Consists of functions and VIs for I'ile YO,

0

Communication subpalette, Consiste of networking Vis lor H0 Dl )13,
Apple Events, and OLE.

e
&

'Insur'u.merit 'O subpalne'f_l-c. Consists of VIs for GPIB, serial, and VISA
instrument control. -

i

y Data Acquisition subpalette. Conststs of VIs for pluz-in data acquisition

8
e
boards.
: ZJ;7¥) Analysis subpalette. Consists of data analysis Vls.
b
¥] Tutorial subpalette. Consists of VIs used in the LabVIEW tutoral.
e Advanced subpalette. Consists of miscellaneous functions such as the call
= | library function, memory functions, data manipulation, and so on.

LabVIFW Basics | Course Manual, 18 & Natronal nstruments Corporatio
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Cesson | nfradusion o LIOVIEW

Application Contro! subpaletic. Consisis of functions and Vs for
LabVIEW server capability, programmatic printing, changing LabVIEW
menus, showing the Help window, and stopping or exiting LabVIEW.

Seiect 4 VI, subpaictte. Consists of = diatog box forinverting subVis into
the current VI

User Libraries subpalette. Location for placing users’ Vis. Any wis or Vi
librarics you place into lhe user . 1ib directory will appear in this
subpalette after you refaunch LabVIEW.

,ASIC

<
The Basics Course subpalette E (User Libraries » Basics Course)
consists of VIs used in tie Lab VIEW Basics | Course.”

Inite Likd
~d

(nstrument Drivers subpalette. Location for placing instrument driver Vis.
Any VIsor VI libraries you place intothe instr. 1ibdirectory will appear
in this subpalette after you relaunch LabVIEW.

You can load and save Vis to/ffrom a special file calleda Vi library {(normally
a file with the . 11b extension). The BASICS.LLB library is an example of
a VI library. Advantages o using VI libraries include:

. With VI libraries, youcan use up Lo 255 characters to name vour VIs,
including the .vi cxtension.

. VI librarics compress Vis to save disk space (they are decompressed
at load time).

. Because multiple Visareina single file, it is easier Lo ransfer VIs
between COMpUicrs.

Other VI Library characteristics include:

« V[ libraries are not hierarchal in nature. That is, you cannct create @
V1 Library within another VIiibrary.

¢ Saving and jeading Vis to and lrom the filc system is faster than to
and from Vi Hbraries.

1-19 L oOVIEW Basics ¢ Course Manual



Lesson 2 Cluslers

A. Clusters

A cluster is a data structure that combines one or more data components nto
a new data type. The components that form a cluster may even have different
data types. For example, you can combine Boolean, string, and integer data
types into a new data type. A cluster is analogous to a record in Pascal ora
struct in C.

On the block diagram, a wire that carrics the data stored in a cluster may be
thought of as a bundle of smaller wires, much like a telephone cable. cach
wire in the cable represents a different component of the cluster. Because a
cluster constitutes only onc “wire” in the block diagram, clusters reduce
wire clutter and the number of connector terminals that subVIs need.

You “unbundle” the cluster in the diagram 10 aCCEsS its components. You

may think of unbundling 2 cluster as unwrapping a telephorne cable and
accessing the individual wires within the cable.

o .::.;'.J

Creating Cluster Conlrols and Indicators On the Front Panel

You create cluster controls and indicators on a VT’s front panel by placing a
cluster shell in the Panel window. To place an empty ¢cluster shell on the
panel, choose Array & Cluster » Cluster from the Controls palette. Then,
click in the Panel window to place the cluster. You can adjust the size of the
cluster shell by holding down the mouse button and dragging the cursor
when placing the cluster shell on the panel.

LEbVIEW Basles It Course Manual 2-2 © Natlonal Instruments Corporation



You can place any objects

Panel window. You can deposit
cluster, or you can drag an cbject
Il controls or all indicators.

up inside the
a cluster must be a

controls and indicators inside 1
ster containing contro

indicator into a ¢lu

control. The cluster assumes the
first object you place inside the clu

below.

cluster conticl

lesson 2 Glusters

inside the cluster that you normally place in the
objects directly inside the cluster by popping
into a cluster. Objects inside
You cannot combine both
he same cluster. For example, if you drop ar.
1s, the indicator changes to @

data direction (control or indicator) of the
ster. A cluster with four controls is shown

digital conticl

SWitCh‘ bu[[onl
: Fis

[:reating Cluster Constants on the Bl

To create a cluster constant o
technique as you used on the front pane
Constant from the Functi

Cluster » Cluster

ock Diagram

n the block diagram, you can use the same
1. From the Diagram window, choose
ons palette to create the cluster

shell. Then, place other constants of the appropriate data type within the

cluster shell.

)

1

Funtiuns '

1] L F i
i

i

B

|17

(TER1| 120

1131

Inage

If you have a cluster contr
tocre

© National Instruments Corporation

ate a cluster constant containing the same compo

2-3

ol or indicator on the front panel, and would Like
nents in the diagram,
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Lesson 2 Clusters

Cluster Qrder

you can pop up on its terminal and select Create Constant from the pop-up
menu. This technique is a great time-saver. If you use this methodona
cluster indicator, the constant is wired to the indicator automatically.

cluster .
- cluster ;

digital control

Show .. .

switch 1 :
T DA 0pera - cluster
“aCreatgunh e (75T

rCreate’Coftiol &
5 T SR i
: 'Clea{efiﬁdd:cgtor (il

When LabVIEW manipulates clusters of data, not only are the data types of
the individual components within the cluster important, but also the order of
the components in the cluster. Cluster components have a logical order
unrelated to their position within the shell. The first object placed in the
cluster shell is component 0, the second is component 1, and so or. If you
delete a component, the order adjusts automatically.

You can change the order of the objects within the cluster by popping up on
the cluster border and choosing Cluster Order... from the pop-up menu. A
new set of buttons replaces the toolbar, and the cluster appearance changes
as shown below. The white box on each component shows its current place
in the cluster order. The black box shows a componen:’s new place in the
order.

Cluster Order Moda

Cluster Order

Click to set to E l

Revert to Original
Keap Changes

Current Order |
New Qrder

LabVIEW Basics If Course Manua! 24 © Natlonal instruments Corporatior



Lesson 2 Clusters

To set acluster componenttoa particular index in the cluster order, first type
the desired order number into the “Click to set to” field. Then click on the
desired component. You witl notice that the component’s cluster order index
changes. You will also notice that the cluster order indices of the other
components adjust automatically. To save your changes, click on the OK

igf‘ button in the palette. To revert to the original settings, click on the Revert ic
Revert to Original button. You use this technique to set the cluster order for constanis

Original button  on both the front panel and the block diagram.

The example shown below illustratcs the importance of cluster order. The

front panel contains two simple clusters. In the fipt cluster, component O3
a numeric control, and component [ is a string control. inthe sccond cluster,
component 015 a numeric indicator, and component 1 is a stying indicater
The cluster contro} wires 1o the cluster indicator on the block diagram.

———
l Front Pane!l i
SliistetiEgAtal

[clustes indicator

However, if you change the cluster order of the indicator so the string
indicator is component 0 and the numeric is component 1, the wire
connecting the control to the indicator is broken. If you try to run the VI, you
get an ertor message stating that there 1s a type conflict because the data
types do not match.

cluster contio! clustet indicator «
— B |

© National Instruments Corporation 2-5 1 abVIEW Basics It Course Manua:



Lesson 2 Clusters

Using Clusters to Pass Data to and fram SubVls .
As shown in the figure below, the connector pane of a VI can have a
maximum of 28 terminals. When you use a connector pane that has a large
number of terminals, the terminals are very small. With such smail
terminals, wiring errors are more likely.

_l_
PE

L]

ShE[=0=/I(NAN

[T L]
L1

il
11]
1]

O BHHEL

TIT

R FT]

IITIT
ITIIT
TITOT

TEIT

By bundling a number of controls into a cluster, and passing the cluster to
the subVI, you can overcome the 28-terminal limit of the connector pane.
One cluster control uses one terminal on the connector pane, but thai cluster
can contain several controls. Similarly, one terminal assigned to a cluster
indicator can pass several outputs from the subVI. Because your subVI uses
clusters containing several items each, you can use fewer, and therefore
larger, terminals on the connector pane. This will make for cleaner wiring

on the diagram.

output cluster

LabVIEW Basics If Course Manual 24 © National instruments Corporation



.;Léssbh 3 Crpating 3 SubV!
LI v

b3

. Basic Ideas

L .

The key to creating LabVIEW applicalions 1s understanding and using tre
hierarchical nature of the VL That is, after you creatc a V|, you can use it as
a subVI in the block diagram of a higher-level VI If 2 block diagram has a
Jarge number of icons, you can group them into a lower-level VIt0 maintain
the simplicity of the block diagram. This modular approach makes
applications easy to debug, understand, and maintain. You can jeam more
about application development in the LabVIEW Basics ]I course.

SubVIs are similar to functions or subroutines 1n a conventionai
programming janguage. The following pseudo-code and block diagram
demonstrate the analogy between subVIs and subroutines.

Function Code Calling Program Codc

_ l
main |
( |
averagn (pointl. pointl, i
pointav ! |

function average (inl, inZ, out)

{

out = {inl + in2) Sl

e i e T T ,_14__,{

Calling VI Black Lingrim

LabVIEW Basics | Course Manuai 32 7 © Natipnal Insirumenis Corporation



Lessen 3 Craating & Subv

B. Creating the [con and Connector

A VI that you usc as a subVI needs an icon to represent it in the dlock
diagram ol u calling VI. The subV1 also must have a connector with
terminals (o pass data to and from the higher-tevet VL

Example—Slope Funetion
As an cxampic, consider a VI that calculates the slope of two coordinates.
‘The front puncl and the block diagram for the VI are shown below. To use
this Vas a subVI, you must create an icon and a connector for iz,

$o T B [Too )

.
Flie
2 2
Bt
)
! i
Wy

IEI
AV
f_g]

ﬁ =
ﬁ
1 &

,_
=

t
i

=1

[con
Every VI has a default icon displayed in the upper-right comer of the Panel
and Diagram windows. For Vls, the default icon is a picture of thes
LabVIEW logo and a number indicating how many new VIs you have
opened since launching LabVIEW. You use the Icon Editor to customize the
icon by turning individual pixels on and off. To activate the Icon Editor, pop
up on the default icon in the top right comner of the Panel or Diagram
window and select Edit Icon as shown below,

Fla E& (lpeiate Prowcl Windows Helr . |
AopcatonFod ] [§o 2] [45_=] [@2 <]
o T W i
; I

P

Add Termind
Remove Teimmal
Fatterms »
Aatate 2D Degres:
Flis Horizont sl
Fhio Vedizal
Disconnect All Termunals

Diizonnest Thiy Teiming
This Dornection !t F

il
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Lesson 4 Loons and Charts

A. While Loop
A While Loop repeats part of your block diugramn code rwluple tmes. Yo
place a While Loop in the biock diugram by st sclecting it from
Structures subpalelie of the Functions puiciic.

l ! rm r—""l
-G:USIructure:
abec “ :
——While Loop
4
Y

Da“* [

Jﬁ‘-ﬁ SR EASA M N B

Then use the mouse cursor to click-and-drag a selection arca around
code you want to repeat. When you release ibe inouse hutton, o While
boundary encloses the code you have selecied as shown below.

REIS I

The complated While Loop is a resizable box. You can add additionai block
diagram elements to the While Loop by dragging and dropping them insid
the boundary with the mouse.

Conditional

| !~—-— terminal

[teration
terminal

LabVIEW Basics | Course Manual 4-2 © Nauonal insiruments Coiporaisn



Cenditional
terminal

[l

Reration
termina!
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Lessan 4 Loogs gnd Dnaris

The VI repeats the code inside the While Loop until the Boolean value
passed to the condfri‘ana! terminal (an input terminal} is FALSE. The VI
checks the conditional terminal at the end of each iteration; therefore, the
While Loop nlways executes once. The freration terminal is a numzaric
output terminal that contains the number of times the loop has executed,
starting at zero. (That is, during the first execution of the loop, the iteratior.
terminal contains the number zero.}

A While Loop is equivalent to the following pseudo-code:
Do
Execute Diagram Inside the Loop (which sets the condition)

while the condition is TRUE

In the exampic below, the While Loop executes until the value output from
the subVl1 is less than 10 or the Enable Boolean is FALSE. (The And
function outputs a TRUE only if both inputs are TRUE,; otherwise, it outputs
a FALSE)

J30VIEW Has'cs { Course Maa al



Lessond  Loops and £hans

D. For Loop

" LabVIEW Basics | Course Manuai 4-26

A For Loop repeats part of your biock dizgrar code @ predetenmined
qumber of times. You select a [For Loop from the Steuetures subpalette of
the Functions paletie, and then enciose the code you wani to repeatin the
For Loop boundary. A For Loop (shown below) is u resizable box. The For
Loop has two terminals: the count terminal {an input terminal) and the
iteration terminal (an output terminal). The count terminal specifies the
number of times to execute the loop. The iteration terminal con:ains the
number of times the loop has executed.

U Funciions
. Stuctures .|

@‘ 4 }l
o I Rirswal

+LHStiuctutes

For Loop

The difference between the For Loop and the While Loop is that the For

Loop executes a predetermined number of times. A While Loop stops

repeating the code it encloses only if the value at the conditional termina!

becomes-FALSE. The For Loop is equivalent to the following pseudo-code:
For i = 0 to N-1

Execute Diagram Inside The Loop

& Mationat Instruments Corperaiion



Lesson 4 Loops and Charls

The example below shows a For Loop that generates 100 random rumbers
and displays the points on a waveform chart.

Numeric Conversion

For Loop
count terminal

Until now, all the numeric controls and indicators you have used are
double-precision floating-point numbers. LabVIEW, however, canrepresent
numerics as integers (byte, word, or long) or floating-poini numbers (single,
double. or extended precision). If you wire together two terminals that are
of different data types, LabVIEW will convert one of the terminals to the
sume representation as the other lerminal. As a reminder, LabVIEW places
2 dot, called a coercion dot, on the terminal where the conversion takes
place.

For example, consider the For Loop count terminal. The terminal
represeniation is long integer. If you wirc & double-precision floating-point
number to the count terminal, LabVIEW converts the number to & long
integer. Notice the gray dot in the count terminal of the first For Loop-

Douhle Precision Long Integer

i)
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